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AgendaAgendaAgenda
BLDC Motor Basics
dsPIC® DSC Peripherals for BLDC control - PWM and ADC

lab 1 - “How to get started” by blinking an LED
lab 2 - using the ADC
lab 3 - using the PWM and multiple ADC channels

Control of a BLDC motor with Position Sensors
Lab 4 - Spinning a Sensored BLDC Motor

Review of BLDC Sensorless Techniques
The Back EMF “zero crossing” technique
Implementation on the dsPIC® DSC (AN901)
Commutation and other control loops

Lab 5 - Setting Up and Tuning the Sensorless BLDC Reference
Design
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Control of a BLDC motor with Position SensorsControl of a BLDC motor with Position Sensors
Lab 4 - Spinning a Sensored BLDC MotorLab 4 - Spinning a Sensored BLDC Motor
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The Back EMF “zero crossing” techniqueThe Back EMF “zero crossing” technique
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Lab 5 - Setting Up and Tuning the Sensorless BLDC ReferenceLab 5 - Setting Up and Tuning the Sensorless BLDC Reference
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Learning ObjectivesLearning ObjectivesLearning Objectives

dsPIC® DSC Peripherals used for BLDC
Control:

10-bit ADC
Motor Control PWM

BLDC Basics
BLDC Control Techniques

Sensored Techniques
Sensorless Techniques

Write Code to Spin a Sensored and
Sensorless BLDC Motor

dsPICdsPIC®® DSC Peripherals used for BLDC DSC Peripherals used for BLDC
Control:Control:

10-bit ADC10-bit ADC
Motor Control PWMMotor Control PWM

BLDC BasicsBLDC Basics
BLDC Control TechniquesBLDC Control Techniques

Sensored TechniquesSensored Techniques
Sensorless TechniquesSensorless Techniques

Write Code to Spin a Sensored andWrite Code to Spin a Sensored and
Sensorless BLDC MotorSensorless BLDC Motor
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BLDC Motor BasicsBLDC Motor BasicsBLDC Motor Basics
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The BrushLess DC (BLDC) MotorThe BrushLess DC (BLDC) MotorThe BrushLess DC (BLDC) Motor

An inside out brushed DC motor with
electronic commutation
A modern, much improved, version of the
traditional brushed DC motor.
Field, which has relatively low loss, is
generated on the rotor using permanent
magnets.
Armature, which causes the majority of the
loss, is on the stator which has good
cooling.
The Back EMF is usually somewhere
between being sinusoidal and trapezoidal.

An inside out brushed DC motor withAn inside out brushed DC motor with
electronic commutationelectronic commutation
A modern, much improved, version of theA modern, much improved, version of the
traditional brushed DC motor.traditional brushed DC motor.
Field, which has relatively low loss, isField, which has relatively low loss, is
generated on the rotor using permanentgenerated on the rotor using permanent
magnets.magnets.
Armature, which causes the majority of theArmature, which causes the majority of the
loss, is on the stator which has goodloss, is on the stator which has good
cooling.cooling.
The Back EMF is usually somewhereThe Back EMF is usually somewhere
between being sinusoidal and trapezoidal.between being sinusoidal and trapezoidal.
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Brushed & Brushless DC Motor
Construction

Brushed & Brushless DC MotorBrushed & Brushless DC Motor
ConstructionConstruction

PERMANENT MAGNET BRUSHED DC
MOTOR

PERMANENT MAGNET BRUSHLESS
DC MOTOR
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BLDC Advantages Over Brushed
DC Motor

BLDC Advantages Over BrushedBLDC Advantages Over Brushed
DC MotorDC Motor

Smaller size for same power owing, mainly,
to the improved cooling of the armature.
Operation to higher speeds.
Lower inertia as no commutator or rotor
windings.
Therefore much higher acceleration rates
possible.
No brushes to maintain.
No sparking on Commutator.

Smaller size for same power owing, mainly,Smaller size for same power owing, mainly,
to the improved cooling of the armature.to the improved cooling of the armature.
Operation to higher speeds.Operation to higher speeds.
Lower inertia as no commutator or rotorLower inertia as no commutator or rotor
windings.windings.
Therefore much higher acceleration ratesTherefore much higher acceleration rates
possible.possible.
No brushes to maintain.No brushes to maintain.
No sparking on Commutator.No sparking on Commutator.
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BLDC ControlBLDC ControlBLDC Control

Mechanical commutator of brushed motor replaced
by electronic switching of the phases.
Switching must be correctly synchronised to
absolute rotor position to ensure smooth and
efficient torque production.
The BLDC is a synchronous motor with no
damping or starting windings.
All discussions will focus on Y connected 3 phase
motors with 3 leg inverters and square wave (120°)
conduction.

Mechanical commutator of brushed motor replacedMechanical commutator of brushed motor replaced
by electronic switching of the phases.by electronic switching of the phases.
Switching must be correctly synchronised toSwitching must be correctly synchronised to
absoluteabsolute rotor position to ensure smooth and rotor position to ensure smooth and
efficient torque production.efficient torque production.
The BLDC is a synchronous motor with noThe BLDC is a synchronous motor with no
damping or starting windings.damping or starting windings.
All discussions will focus on Y connected 3 phaseAll discussions will focus on Y connected 3 phase
motors with 3 leg inverters and square wave (120motors with 3 leg inverters and square wave (120°°))
conductionconduction..
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Standard BLDC Position SensingStandard BLDC Position SensingStandard BLDC Position Sensing

A sensing disk is attached to the rotor which
provides a ˜ 50% duty pattern aligned to the
rotor magnets. The repetition rate of the
pattern will follow the number of rotor poles.
The disk is monitored by three optical or hall
sensors, displaced by the equivalent of
120°, located on the stator.
In the case of hall sensors, the rotor
magnets themselves may be sensed
directly.

A sensing disk is attached to the rotor whichA sensing disk is attached to the rotor which
provides a provides a ˜̃ 50% duty pattern aligned to the50% duty pattern aligned to the
rotor magnets. The repetition rate of therotor magnets. The repetition rate of the
pattern will follow the number of rotor poles.pattern will follow the number of rotor poles.
The disk is monitored by three optical or hallThe disk is monitored by three optical or hall
sensors, displaced by the equivalent ofsensors, displaced by the equivalent of
120120°°, located on the stator., located on the stator.
In the case of hall sensors, the rotorIn the case of hall sensors, the rotor
magnets themselves may be sensedmagnets themselves may be sensed
directly.directly.
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Brushless DC Motor ConstructionBrushless DC Motor ConstructionBrushless DC Motor Construction
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Standard Sensored BLDC
Control

Standard Sensored BLDCStandard Sensored BLDC
ControlControl

The 3 logic signals are decoded to determine
which windings should be energized.
There are 6 valid states and 2 states that should
never be seen (000, 111).
Use Lookup table to drive the 3 windings, high or
low or no-drive.
The 6 different valid states directly translate to the
6 different 60° electrical cycle sectors.
The states should only transition by one at a time.
Missing transitions or invalid states should be
detected for robust operation.

The 3 logic signals are decoded to determineThe 3 logic signals are decoded to determine
which windings should be energized.which windings should be energized.
There are 6 valid states and 2 states that shouldThere are 6 valid states and 2 states that should
never be seen (000, 111).never be seen (000, 111).
Use Lookup table to drive the 3 windings, high orUse Lookup table to drive the 3 windings, high or
low or no-drive.low or no-drive.
The 6 different valid states directly translate to theThe 6 different valid states directly translate to the
6 different 606 different 60°° electrical cycle sectors. electrical cycle sectors.
The states should only transition by one at a time.The states should only transition by one at a time.
Missing transitions or invalid states should beMissing transitions or invalid states should be
detected for robust operation.detected for robust operation.
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Standard BLDC ControlStandard BLDC ControlStandard BLDC Control
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16-bit Digital Signal Controller

Architecture

16-bit Digital Signal Controller16-bit Digital Signal Controller

ArchitectureArchitecture
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dsPIC30F Controller FamilydsPIC30F Controller FamilydsPIC30F Controller Family

Flash Program Memory: 12 K - 144 K Bytes
RAM 512 - 8 K bytes
Data EEPROM 1K - 4K Bytes
Pin-count 18 - 80 pins
Timers 16-bit Up to 5
Input Capture Up to 8
Output Compare / PWM Up to 8 (individual time bases)
Motor Control PWM 6 or 8 with shutdown pins
A/D converter 10-bit, 500 KSPS, up to 16 ch
A/D converter 12-bit, 100 KSPS, up to 16 ch
UART 1 - 2
SPI™  (8/16-bit) 1 - 2
I2C™ 1
QEI 1
CODEC interface 1
CAN 1 - 2

Flash Program Memory:Flash Program Memory: 12 K - 144 K Bytes12 K - 144 K Bytes
RAMRAM 512 - 8 K bytes512 - 8 K bytes
Data EEPROMData EEPROM 1K - 4K Bytes1K - 4K Bytes
Pin-countPin-count 18 - 80 pins18 - 80 pins
Timers 16-bitTimers 16-bit Up to 5Up to 5
Input CaptureInput Capture Up to 8Up to 8
Output Compare / PWMOutput Compare / PWM Up to 8 (individual time bases)Up to 8 (individual time bases)
Motor Control PWMMotor Control PWM 6 or 8 with shutdown pins6 or 8 with shutdown pins
A/D converterA/D converter 10-bit, 500 KSPS, up to 16 ch10-bit, 500 KSPS, up to 16 ch
A/D converterA/D converter 12-bit, 100 KSPS, up to 16 ch12-bit, 100 KSPS, up to 16 ch
UARTUART 1 - 21 - 2
SPI™SPI™  (8/16-bit) (8/16-bit) 1 - 21 - 2
II22C™C™ 11
QEIQEI 11
CODEC interfaceCODEC interface 11
CANCAN 1 - 21 - 2
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Operating ParametersOperating ParametersOperating Parameters

Operating Speed @ 5V (-40ºC to 85ºC) : 30 MIPS

VDD: 2.5  to 5.5V

Temp: -40º C to 125º C

Program Memory: Flash

Data Memory: SRAM, EEPROM

Analog: 10-bit & 12-bit Precision

Package sizes
18-pin SO & SP
28-pin SO, SP and QFN
40-pin SP;  44-pin TQFP
64- and 80-pin TQFP

Operating Speed @ 5V (-40ºC to 85ºC) : 30 MIPSOperating Speed @ 5V (-40ºC to 85ºC) : 30 MIPS

VVDDDD:: 2.5  to 5.5V2.5  to 5.5V

Temp:Temp: -40º C to 125º C-40º C to 125º C

Program Memory:Program Memory: FlashFlash

Data Memory:Data Memory: SRAM, EEPROMSRAM, EEPROM

Analog:Analog: 10-bit & 12-bit Precision10-bit & 12-bit Precision

Package sizesPackage sizes
18-pin SO & SP18-pin SO & SP
28-pin SO, SP and QFN28-pin SO, SP and QFN
40-pin SP;  44-pin TQFP40-pin SP;  44-pin TQFP
64- and 80-pin TQFP64- and 80-pin TQFP

D
S
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Program MemoryProgram MemoryProgram Memory

Modified Harvard Bus
Architecture

Single Core : MCU + DSP

Instruction is 24-bit wide

Total Architecture Reach:
4M x 24-bit Linear Program

Space

Devices contain up to 144K
byte Flash Memory

No Paging or Segmentation

Modified Harvard BusModified Harvard Bus
ArchitectureArchitecture

Single Core : MCU + DSPSingle Core : MCU + DSP

Instruction is 24-bit wideInstruction is 24-bit wide

Total Architecture Reach:Total Architecture Reach:
4M x 24-bit4M x 24-bit Linear ProgramLinear Program

SpaceSpace

Devices contain up to 144KDevices contain up to 144K
byte Flash Memorybyte Flash Memory

No Paging or SegmentationNo Paging or Segmentation

144K Flash144K Flash

4M4M
TotalTotal

24 Bit24 Bit
InstructionInstruction
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Up to 4K bytes Data EE Memory
Run-Time programmable
Row and Word erasable
Row and Word programmable
Modify a Row of 16 words in 2 milliseconds
Can access Data EEPROM for 16-bit data read
operations

Up to 4K bytes Data EE MemoryUp to 4K bytes Data EE Memory
Run-Time programmableRun-Time programmable
Row and Word erasableRow and Word erasable
Row and Word programmableRow and Word programmable
Modify a Row of 16 words in 2 millisecondsModify a Row of 16 words in 2 milliseconds
Can access Data EEPROM for 16-bit data readCan access Data EEPROM for 16-bit data read
operationsoperations

MOV  [++w4], [w6++]

Data EE Memory used as source address for data read operation

Data EEPROM MemoryData EEPROM MemoryData EEPROM Memory
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Data MemoryData MemoryData Memory

Data is 16-bit wide
Byte addressable

Total Space:
64K Bytes Linear Data Space

No Banking

Devices contain up to 8K Byte
User RAM

Addressable Indirectly or with
Memory Direct ‘MOV’ Instruction

Data is 16-bit wideData is 16-bit wide
Byte addressableByte addressable

Total Space:Total Space:
64K Bytes Linear Data Space64K Bytes Linear Data Space

No BankingNo Banking

Devices contain up to 8K ByteDevices contain up to 8K Byte
User RAMUser RAM

Addressable Indirectly or withAddressable Indirectly or with
Memory Direct ‘Memory Direct ‘MOVMOV’ Instruction’ Instruction 8K RAM8K RAM

64K64K
TotalTotal

16 Bit Data16 Bit Data
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Programmers ModelProgrammers ModelProgrammers Model

Stack Pointer 

W Registers

General Purpose
Data Registers 

or
Address Pointers 

DSP OPERAND
Registers

DSP ADDRESS
Registers

DSP Accumulators 
(40-bit)

ACCA
ACCB

Status Register

W0
W1
W2
W3
W4
W5
W6
W7
W8
W9

W10
W11
W12
W13
W14
W15

1515 00

0015151616313132323939

Frame Pointer 

CZOVNRAIPL1IPL2SABOABSBSAOBOA DA DC IPL0

      Divide Quotient
    Divide Remainder

Stack Pointer Limit 
     15     15      0     0

SPLIM 

     0     0
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Interrupt SubsystemInterrupt SubsystemInterrupt Subsystem
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Reset - GOTO Address
Reserved

Address Error Trap
Stack Error Trap

Math Error Trap
Reserved
Reserved
Reserved 

Oscillator Fail Trap

Interrupt Vector 0 
Interrupt Vector 1 
Interrupt Vector 2 

 •
• 

Interrupt Vector 53 
Reserved

0x000000

0x000084

0x0000FE

Interrupt Vector
Table (IVT)

0x000004

Reset - GOTO Instruction

Reserved

0x00007E

Oscillator Fail Trap

Interrupt Vector 53 

• 
 •
• 
• 

Alternate
Interrupt Vector

Table (AIVT)

Decreasing Natural Order Priority

Interrupt Vector TableInterrupt Vector TableInterrupt Vector Table

Reserved
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Traps for Robust OperationTraps for Robust OperationTraps for Robust Operation

Oscillator Failure Trap (level 14)
Address Error Trap (level 13)

Instruction fetch from illegal program space
Data fetch from unimplemented data space
Unaligned word access from data space

Stack Error Trap (level 12)
Stack overflow or underflow

Arithmetic Error Trap (level 11)
Divide by Zero
Unsaturated Accumulator Overflow (A or B)
Catastrophic Accumulator Overflow (either)
Accumulator Shift Overflow

Oscillator Failure Trap (level 14)Oscillator Failure Trap (level 14)
Address Error Trap (level 13)Address Error Trap (level 13)

Instruction fetch from illegal program spaceInstruction fetch from illegal program space
Data fetch from unimplemented data spaceData fetch from unimplemented data space
Unaligned word access from data spaceUnaligned word access from data space

Stack Error Trap (level 12)Stack Error Trap (level 12)
Stack overflow or underflowStack overflow or underflow

Arithmetic Error Trap (level 11)Arithmetic Error Trap (level 11)
Divide by ZeroDivide by Zero
Unsaturated Accumulator Overflow (A or B)Unsaturated Accumulator Overflow (A or B)
Catastrophic Accumulator Overflow (either)Catastrophic Accumulator Overflow (either)
Accumulator Shift OverflowAccumulator Shift Overflow
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 System Management Features System Management Features System Management Features
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 System Management
Features

 System Management System Management
FeaturesFeatures

dsPIC® DSC has the same system management
features that PIC® MCU users love

♥Configurable Watchdog Timer with its own RC oscillator
Programmable Time out: 2 ms - 16 sec

♥ Power-On-Reset with a programmable delay 0, 4, 16, 64
ms

♥ Brown-out Reset with programmable levels
♥ Low VDD Detect Interrupt with programmable levels

dsPICdsPIC®® DSC has the same system management DSC has the same system management
features that PICfeatures that PIC®® MCU users love MCU users love

♥♥ Configurable Configurable Watchdog TimerWatchdog Timer with its own RC oscillator with its own RC oscillator
Programmable Time out: 2 ms - 16 secProgrammable Time out: 2 ms - 16 sec

♥♥ Power-On-ResetPower-On-Reset with a programmable delay 0, 4, 16, 64 with a programmable delay 0, 4, 16, 64
msms

♥♥ Brown-out ResetBrown-out Reset with programmable levels with programmable levels
♥♥ Low VLow VDDDD Detect Interrupt Detect Interrupt with programmable levels with programmable levels
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 Clock sources Clock sources Clock sources

XTL, XT, HS
Primary
Xtal OSC

Clock Divide
By

 1, 4, 16, 64

32KHz
Timer1 Xtal

OSC

System
Clock

Fast RC  8.0 MHz

Low Pwr RC 512KHz

EC ClockEC Clock

SOSCI

SOSCO

OSCI

OSCO

PLL
4x,
8x,
16x

or bypass

Includes 2 Internal RC OscillatorsIncludes 2 Internal RC OscillatorsIncludes 2 Internal RC Oscillators

Primary Oscillator for CrystalsPrimary Oscillator for Crystals

PLL multiplies oscillator source
for high frequency operation
PLL multiplies oscillator source
for high frequency operation

Clock divide can optionally slow clock
to conserve power
Clock divide can optionally slow clock
to conserve power

32 kHz for Real Time Clock32 kHz for Real Time Clock
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Fail-Safe OperationFail-Safe OperationFail-Safe Operation
Features that make the target system safe!

Clock monitor detects oscillator failure
Automatic switch to an internal RC clock

Illegal Program Instruction
Device Resets

Traps let software handle error conditions
Oscillator Fail
Address out of range
Stack out of range
Math errors

Features that make the target system safe!Features that make the target system safe!

Clock monitor detects oscillator failureClock monitor detects oscillator failure
Automatic switch to an internal RC clockAutomatic switch to an internal RC clock

Illegal Program InstructionIllegal Program Instruction
Device ResetsDevice Resets

Traps let software handle error conditionsTraps let software handle error conditions
Oscillator FailOscillator Fail
Address out of rangeAddress out of range
Stack out of rangeStack out of range
Math errorsMath errors
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LAB 1LAB 1LAB 1

Getting Started with the dsPIC® DSC BLDC
board
Objectives for Lab:

Configure board hardware connections
Open a workspace in MPLAB® IDE
Compile or Build the project in MPLAB IDE
Follow procedure to Program  the dsPIC DSC
using ICD 2
Follow procedure to Run the program using
ICD 2

Getting Started with the dsPICGetting Started with the dsPIC®® DSC BLDC DSC BLDC
boardboard
Objectives for Lab:Objectives for Lab:

Configure board hardware connectionsConfigure board hardware connections
Open a workspace in MPLABOpen a workspace in MPLAB® ® IDEIDE
Compile or Build the project in MPLAB IDECompile or Build the project in MPLAB IDE
Follow procedure to Program  the dsPIC DSCFollow procedure to Program  the dsPIC DSC
using ICD 2using ICD 2
Follow procedure to Run the program usingFollow procedure to Run the program using
ICD 2ICD 2
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You should have….You should have….You should have….

1) MPLAB® IDE V6.5 or higher installed
2) Complete MPLAB® ICD 2 setup
3) BLDC motor control board(05-60001)
4) 24V power supply for the above board
5) Hurst(NTDynamo) BLDC motor with

Power cable (4 wires with white square connector) and
Hall sensor cable (5 wires with 8-pin inline connector)

6) Circuit schematic BLDC motor control board

1)1) MPLABMPLAB®® IDE V6.5 or higher installed IDE V6.5 or higher installed
2)2) Complete MPLABComplete MPLAB®® ICD 2 setup ICD 2 setup
3)3) BLDC motor control board(05-60001)BLDC motor control board(05-60001)
4)4) 24V power supply for the above board24V power supply for the above board
5) 5) Hurst(NTDynamo) BLDC motor withHurst(NTDynamo) BLDC motor with

Power cable (4 wires with white square connector) andPower cable (4 wires with white square connector) and
Hall sensor cable (5 wires with 8-pin inline connector)Hall sensor cable (5 wires with 8-pin inline connector)

6)6) Circuit schematic BLDC motor control boardCircuit schematic BLDC motor control board
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Training board - TopTraining board - TopTraining board - Top

Reset

Power

S3 

S2

dsPIC30F2010

ICD 2 connectorSerial connector

Motor 
connector

R60

Led D1

DIP Switches
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Training board - BottomTraining board - BottomTraining board - Bottom

Power
MOSFETs



© 2004 Microchip Technology Incorporated. All Rights Reserved.     845 SNS 845 SNS     Sensor and Sensorless Control of a BLDC motor using a dsPIC     Sensor and Sensorless Control of a BLDC motor using a dsPIC® ® DSC      DSC       31

Jumpers and LEDsJumpers and LEDsJumpers and LEDs

Power LED
D7

dsPIC30f2010

Jumpers
 J7, J8, J11, J12, J13, J14

LEDs
D1
D2
D3

Jumper 
J15

Jumper J2

LEDs
PWM0 

to
PWM5
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Default Jumper settingsDefault Jumper settingsDefault Jumper settings

J2(2 pin)  - shorted.
J15(3 pin) - shorted between pin 2 & 3
(short link towards the crystal oscillator)

J7, J11 and J13 - shorted between pin 3 & 2
(short link away from ICD 2 connector)

JP8, JP12, JP14, JP16 and JP17 keep open
Keep Potentiometer REF(R14) and R60 in
center position

J2J2(2 pin)  - shorted.(2 pin)  - shorted.
J15J15(3 pin) - shorted between pin 2 & 3(3 pin) - shorted between pin 2 & 3
(short link towards the crystal oscillator)(short link towards the crystal oscillator)

J7, J11J7, J11 and  and J13J13 - shorted between pin 3 & 2 - shorted between pin 3 & 2
(short link away from ICD 2 connector)(short link away from ICD 2 connector)

JP8, JP12, JP14, JP16 and JP17JP8, JP12, JP14, JP16 and JP17 keep open keep open
Keep Potentiometer Keep Potentiometer REF(R14) and R60REF(R14) and R60 in in
center positioncenter position
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Lab1Lab1Lab1

Instructions for Lab1:
Make sure the DIP switches are in the
CLOSE position (not OPEN)
Connect power to System
Open MPLAB® IDE by double clicking on
icon
Select “File -> Open Workspace”
Browse to
“C:\MASTERs\845\Lab1\Lab1.mcw”
Select “Lab1.mcw” to open workspace

Contd ...

Instructions for Lab1:Instructions for Lab1:
Make sure the DIP switches are in theMake sure the DIP switches are in the
CLOSE position (not OPEN)CLOSE position (not OPEN)
Connect power to SystemConnect power to System
Open MPLABOpen MPLAB®® IDE by double clicking on IDE by double clicking on
iconicon
Select “File -> Open Workspace”Select “File -> Open Workspace”
Browse toBrowse to
“C:\MASTERs\845\Lab1\Lab1.mcw”“C:\MASTERs\845\Lab1\Lab1.mcw”
Select “Lab1.mcw” to open workspaceSelect “Lab1.mcw” to open workspace

Contd ...Contd ...
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Lab 1 (contd.)Lab 1 (contd.)Lab 1 (contd.)

Instructions for Lab1 (contd):
Select “Debugger -> Build All”
IF NO errors then ...
Select “Debugger -> Program” to program
Move DIP switches to OPEN position
Select “Debugger -> Run” and D1 should
blink

Instructions for Lab1 (contd):Instructions for Lab1 (contd):
Select “Debugger -> Build All”Select “Debugger -> Build All”
IF NO errors then ...IF NO errors then ...
Select “Debugger -> Program” to programSelect “Debugger -> Program” to program
Move DIP switches to OPEN positionMove DIP switches to OPEN position
Select “Debugger -> Run” and D1 shouldSelect “Debugger -> Run” and D1 should
blinkblink
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Lab1 ResultsLab1 ResultsLab1 Results
This same procedure has to be followed for
programming and running software:

When programming, move DIPs to CLOSE
position (not OPEN)
When running, move DIPs in OPEN position

Each Lab has a  workspace in the
appropriate folder already created
Use the workspace for each lab
If D1 is blinking, your system is functional -
Congratulations!!!!

This same procedure has to be followed forThis same procedure has to be followed for
programming and running software:programming and running software:

When programming, move DIPs to CLOSEWhen programming, move DIPs to CLOSE
position (not OPEN)position (not OPEN)
When running, move DIPs in OPEN positionWhen running, move DIPs in OPEN position

Each Lab has a  workspace in theEach Lab has a  workspace in the
appropriate folder already createdappropriate folder already created
Use the workspace for each labUse the workspace for each lab
If D1 is blinking, your system is functional -If D1 is blinking, your system is functional -
Congratulations!!!!Congratulations!!!!
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10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter
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dsPIC 10-bit A/D ConverterdsPICdsPIC 10-bit A/D Converter 10-bit A/D Converter

Feature Summary
10-bit  Resolution with +/- 1 bit accuracy
500K Samples/Sec conversion rate
Up to 16 input channels, 4 S/H Amplifiers
Unipolar differential measurements
External VREF+ and VREF-
Many sampling sequences can be
programmed
Multiple conversion trigger sources

Feature SummaryFeature Summary
10-bit  Resolution with +/- 1 bit accuracy10-bit  Resolution with +/- 1 bit accuracy
500K Samples/Sec conversion rate500K Samples/Sec conversion rate
Up to 16 input channels, Up to 16 input channels, 4 S/H Amplifiers4 S/H Amplifiers
Unipolar differential measurementsUnipolar differential measurements
External VExternal VREFREF+ and V+ and VREFREF--
Many sampling sequences can beMany sampling sequences can be
programmedprogrammed
Multiple conversion trigger sourcesMultiple conversion trigger sources
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10-bit A/D Block Diagram10-bit A/D Block Diagram10-bit A/D Block Diagram
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VREF-VREF-
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10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

A/D Configuration for Labs
Lab 2 - Sample one channel, manual
sampling, manual conversion
Lab 3 - Simultaneously sample 4
channels, auto sample, trigger
conversion from PWM

Keep these configurations in mind as
we look at the A/D control registers

A/D Configuration for LabsA/D Configuration for Labs
Lab 2 - Sample one channel, manualLab 2 - Sample one channel, manual
sampling, manual conversionsampling, manual conversion
Lab 3 - Simultaneously sample 4Lab 3 - Simultaneously sample 4
channels, auto sample, triggerchannels, auto sample, trigger
conversion from PWMconversion from PWM

Keep these configurations in mind asKeep these configurations in mind as
we look at the A/D control registerswe look at the A/D control registers
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10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

ADCON1 Register Bits
DONE - A/D conversion status
SAMP - A/D sampling status/control
ASAM - Auto sample control bit
SIMSAM - Simultaneous sample control
SSRC - Conversion trigger source
FORM - Result format
ADSIDL - Stop in IDLE control bit
ADON - A/D enable bit (set last)

ADCON1 Register BitsADCON1 Register Bits
DONE - A/D conversion statusDONE - A/D conversion status
SAMP - A/D sampling status/controlSAMP - A/D sampling status/control
ASAM - Auto sample control bitASAM - Auto sample control bit
SIMSAM - Simultaneous sample controlSIMSAM - Simultaneous sample control
SSRC - Conversion trigger sourceSSRC - Conversion trigger source
FORM - Result formatFORM - Result format
ADSIDL - Stop in IDLE control bitADSIDL - Stop in IDLE control bit
ADON - A/D enable bit ADON - A/D enable bit (set last)(set last)
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10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

A/D Conversion Trigger Options
Auto convert (internal counter)
Motor Control PWM special event trigger

allows synchronized shunt current
measurement

Timer3 period match event
Edge input on I/O pin
Manual trigger

user clears SAMP bit to begin CONV

A/D Conversion Trigger OptionsA/D Conversion Trigger Options
Auto convert (internal counter)Auto convert (internal counter)
Motor Control PWM special event triggerMotor Control PWM special event trigger

allows synchronized shunt currentallows synchronized shunt current
measurementmeasurement

Timer3 period match eventTimer3 period match event
Edge input on I/O pinEdge input on I/O pin
Manual triggerManual trigger

user clears SAMP bit to begin CONVuser clears SAMP bit to begin CONV



© 2004 Microchip Technology Incorporated. All Rights Reserved.     845 SNS 845 SNS     Sensor and Sensorless Control of a BLDC motor using a dsPIC     Sensor and Sensorless Control of a BLDC motor using a dsPIC® ® DSC      DSC       42

10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

ADCON2 Register Bits
ALTS - Alternate MUX sample mode
BUFM - Buffer mode control bit
SMPI - Samples per interrupt
BUFS - Buffer status
CHPS - S/H Channels per Sample
CSCNA - MUX A Scan enable bit
VCFG - Voltage Ref configuration

ADCON2 Register BitsADCON2 Register Bits
ALTS - Alternate MUX sample modeALTS - Alternate MUX sample mode
BUFM - Buffer mode control bitBUFM - Buffer mode control bit
SMPI - Samples per interruptSMPI - Samples per interrupt
BUFS - Buffer statusBUFS - Buffer status
CHPS - S/H Channels per SampleCHPS - S/H Channels per Sample
CSCNA - MUX A Scan enable bitCSCNA - MUX A Scan enable bit
VCFG - Voltage Ref configurationVCFG - Voltage Ref configuration
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10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

A/D Sampling Options
1, 2, or 4 S/H amplifiers for conversions

Simultaneous or sequentially sampled
Scan mode with enable for each input
Two multiplexer settings can be programmed

Alternate  between conversions
Selectable number of samples per interrupt
Selectable buffer fill mode
Auto  or manual sample

A/D Sampling OptionsA/D Sampling Options
1, 2, or 4 S/H amplifiers for conversions1, 2, or 4 S/H amplifiers for conversions

Simultaneous or sequentially sampledSimultaneous or sequentially sampled
Scan mode with enable for each inputScan mode with enable for each input
Two multiplexer settings can be programmedTwo multiplexer settings can be programmed

Alternate  between conversionsAlternate  between conversions
Selectable number of samples per interruptSelectable number of samples per interrupt
Selectable buffer fill modeSelectable buffer fill mode
Auto  or manual sampleAuto  or manual sample
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Sampling OptionsSampling OptionsSampling Options

AN0

AN1

AN2

AN3

SIMULTANEOUS
SAMPLING

SEQUENTIAL
SAMPLING

AN0

AN1

AN2

AN3

SIMULTANEOUS
SAMPLING

SEQUENTIAL
SAMPLING
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10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

ADCON3 Register Bits
ADCS - A/D Clock setting (Tad)

Tcy/2 increments,  167ns min
ADRC - A/D RC oscillator
SAMC - Auto Sample Time bits

ADCON3 Register BitsADCON3 Register Bits
ADCS - A/D Clock setting (Tad)ADCS - A/D Clock setting (Tad)

Tcy/2 increments,  167ns minTcy/2 increments,  167ns min
ADRC - A/D RC oscillatorADRC - A/D RC oscillator
SAMC - Auto Sample Time bitsSAMC - Auto Sample Time bits
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10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

ADPCFG Register
Sets port pin for analog (default) or digital
mode

ADCSSL - A/D Input Scan Select Register
Use when CSCNA bit set

ADPCFG RegisterADPCFG Register
Sets port pin for analog (default) or digitalSets port pin for analog (default) or digital
modemode

ADCSSL - A/D Input Scan Select RegisterADCSSL - A/D Input Scan Select Register
Use when CSCNA bit setUse when CSCNA bit set
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Lab2 - Single channel ADC
Conversion

Lab2 - Single channel ADCLab2 - Single channel ADC
ConversionConversion

Instructions for Lab2:
Use workspace
“C:\MASTERs\845\Lab2\Lab2.mcw”
Write code to setup ADC:

Convert single Pot REF on AN2(RB2)
Use Manual Sample by setting SAMP bit
every 100 mS (use Delay100 mS routine)
Manually check conversion complete
Use Internal RC for Tad

….. Contd.

Instructions for Lab2:Instructions for Lab2:
Use workspaceUse workspace
“C:\MASTERs\845\Lab2\Lab2.mcw”“C:\MASTERs\845\Lab2\Lab2.mcw”
Write code to setup ADC:Write code to setup ADC:

Convert single Pot REF on AN2(RB2)Convert single Pot REF on AN2(RB2)
Use Manual Sample by setting SAMP bitUse Manual Sample by setting SAMP bit
every 100 mS (use Delay100 mS routine)every 100 mS (use Delay100 mS routine)
Manually check conversion completeManually check conversion complete
Use Internal RC for TadUse Internal RC for Tad

….. Contd.….. Contd.
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Lab2 - Single channel ADC
Conversion (contd.)

Lab2 - Single channel ADCLab2 - Single channel ADC
Conversion (contd.)Conversion (contd.)

Code to be modified clearly marked:
 “Replace text with Code”

Compile the program using “Project -> Build
All”
If no errors then Program the part  but ...
MAKE SURE DIPs are in CLOSE position
Use “Debugger -> Program” to program part
MAKE SURE DIPs are in OPEN position

Contd ...

Code to be modified clearly marked:Code to be modified clearly marked:
 “Replace text with Code” “Replace text with Code”

Compile the program using “Project -> BuildCompile the program using “Project -> Build
All”All”
If no errors then Program the part  but ...If no errors then Program the part  but ...
MAKE SURE DIPs are in CLOSE positionMAKE SURE DIPs are in CLOSE position
Use “Debugger -> Program” to program partUse “Debugger -> Program” to program part
MAKE SURE DIPs are in OPEN positionMAKE SURE DIPs are in OPEN position

Contd ...Contd ...
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Lab2 - Single channel ADC
Conversion (contd.)

Lab2 - Single channel ADCLab2 - Single channel ADC
Conversion (contd.)Conversion (contd.)

In Windows®:
Open Hyperterm “Lab2.ht” in Lab2
directory.
If Bottom Status reads “Disconnected” then
connect by selecting: “Call -> Call”

In MPLAB® IDE, Run the program: “Debugger -
> RUN”
Turn POT REF to view different values in
Hyperterm.

In WindowsIn Windows®®::
Open Hyperterm “Lab2.ht” in Lab2Open Hyperterm “Lab2.ht” in Lab2
directory.directory.
If Bottom Status reads “Disconnected” thenIf Bottom Status reads “Disconnected” then
connect by selecting: “Call -> Call”connect by selecting: “Call -> Call”

In MPLABIn MPLAB® ® IDE, Run the program: “Debugger -IDE, Run the program: “Debugger -
> RUN”> RUN”
Turn POT REF to view different values inTurn POT REF to view different values in
Hyperterm.Hyperterm.
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Lab 2 ResultLab 2 ResultLab 2 Result
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Lab 2 ResultsLab 2 ResultsLab 2 Results

Configuration of 10-bit ADC
Serial communications using dsPIC® DSC
Configuration of 10-bit ADCConfiguration of 10-bit ADC
Serial communications using dsPICSerial communications using dsPIC® ® DSCDSC
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CH0SA<3:0>
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1 bit0
CH0NACHXSACHXNA<1:0>

CH0SB<3:0>
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit15 14 13 12 11 10 9 bit8
CH0NBCHXSBCHXNB<1:0>

ADCHS RegisterADCHS Register

+

-
CH 0

VREF-

AN0 - AN15

AN1

10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

ADCHS Register - CH0 S/H Input SelectionADCHS Register - CH0 S/H Input SelectionADCHS Register - CH0 S/H Input Selection
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10-bit A/D Converter10-bit A/D Converter10-bit A/D Converter

ADCHS - CH1, CH2, CH3 Input SelectADCHS - CH1, CH2, CH3 Input SelectADCHS - CH1, CH2, CH3 Input Select

+

-
CH 2

VREF-

AN1
AN4

AN7

AN10

+

-
CH 3

VREF-

AN2
AN5

AN8

AN11

+

-
CH 1

VREF-

AN0
AN3

AN6

AN9

CH0SA<3:0>
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1 bit0
CH0NACHXSACHXNA<1:0>

CH0SB<3:0>
R/W -0 R/W -0 R/W -0 R/W -0 R/W -0 R/W -0 R/W -0 R/W-0

bit15 14 13 12 11 10 9 bit8
CH0NBCHXSBCHXNB<1:0>

ADCHS RegisterADCHS Register
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Motor Control PWM ModuleMotor Control PWM ModuleMotor Control PWM Module
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Motor Control PWMMotor Control PWMMotor Control PWM

Features Overview
Designed for ACIM, BLDC, SR, UPS
Complementary PWM signals w/ dead time
Independent output mode
Special PWM generation modes
Fault pins for protection of power circuits
Override register for commutation applications
Synchronized A/D conversions

Features OverviewFeatures Overview
Designed for ACIM, BLDC, SR, UPSDesigned for ACIM, BLDC, SR, UPS
Complementary PWM signals w/ dead timeComplementary PWM signals w/ dead time
Independent output modeIndependent output mode
Special PWM generation modesSpecial PWM generation modes
Fault pins for protection of power circuitsFault pins for protection of power circuits
Override register for commutation applicationsOverride register for commutation applications
Synchronized A/D conversionsSynchronized A/D conversions
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Motor Control PWMMotor Control PWMMotor Control PWM

Four PWM outputFour PWM output
pairs with outputpairs with output
polarity controlpolarity control

Duty CycleDuty Cycle

Generator #3Generator #3

Duty CycleDuty Cycle

Generator #2Generator #2

Duty CycleDuty Cycle

Generator #1Generator #1

Duty CycleDuty Cycle

Generator #4Generator #4

PWM OutputPWM Output
Control LogicControl Logic

Dead Time UnitDead Time Unit

Dead Time UnitDead Time Unit

Dead Time UnitDead Time Unit

Dead Time UnitDead Time Unit

Fault AFault A

Fault BFault B

PWM4HPWM4H

PWM1LPWM1L

PWM1HPWM1H

PWM2LPWM2L

PWM2HPWM2H

PWM3LPWM3L

PWM3HPWM3H

PWM4LPWM4L

Two fault pins w/Two fault pins w/
programmable faultprogrammable fault

statesstates

15-bit Time-base15-bit Time-base

A/D ConversionA/D Conversion
TriggerTrigger

Manual OverrideManual Override
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Motor Control PWMMotor Control PWMMotor Control PWM

PTCON register
PTMOD - Timebase Mode
PTCKPS - Timebase clock pre-scale
PTOPS - Timebase interrupt post-scale
PTSIDL - Stop in IDLE mode
PTEN - Timebase Enable

PTCON registerPTCON register
PTMOD - Timebase ModePTMOD - Timebase Mode
PTCKPS - Timebase clock pre-scalePTCKPS - Timebase clock pre-scale
PTOPS - Timebase interrupt post-scalePTOPS - Timebase interrupt post-scale
PTSIDL - Stop in IDLE modePTSIDL - Stop in IDLE mode
PTEN - Timebase EnablePTEN - Timebase Enable

PTMOD<1:0>
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1 bit0
PTCKPS<1:0>PTOPS<3:0>

-
R/W-0 U-0 R/W-0 U-0 U-0 U-0 U-0 U-0

bit15 14 13 12 11 10 9 bit8
----PTSIDL-PTEN
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Motor Control PWMMotor Control PWMMotor Control PWM

Edge Aligned PWMEdge Aligned PWMEdge Aligned PWM

PWM3

PWM1

PWM2

PDC1

PDC2

PDC3

PTPER
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Motor Control PWMMotor Control PWMMotor Control PWM

Center Aligned PWMCenter Aligned PWMCenter Aligned PWM

PWM

buffer
update

buffer
update

duty
cycle

changed

PTPER

We will use center aligned PWM for today’s labs.

PDCx
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Motor Control PWMMotor Control PWMMotor Control PWM

PWM Frequency and Counting Resolution
The 15-bit PTMR increments every Tcy
PTPER sets the counting period in Tcy
16-bit duty cycles allow Tcy/2 edge resolution
Upper 15 bits of d.c. compared to PTMR
LSbit of duty cycle specifies Tcy/2 boundary
Divide count period value by 2 to get PTPER
PWM frequency is halved for center-aligned

PWM Frequency and Counting ResolutionPWM Frequency and Counting Resolution
The 15-bit PTMR increments every TcyThe 15-bit PTMR increments every Tcy
PTPER sets the counting period in TcyPTPER sets the counting period in Tcy
16-bit duty cycles allow Tcy/2 edge resolution16-bit duty cycles allow Tcy/2 edge resolution
Upper 15 bits of d.c. compared to PTMRUpper 15 bits of d.c. compared to PTMR
LSbit of duty cycle specifies Tcy/2 boundaryLSbit of duty cycle specifies Tcy/2 boundary
Divide count period value by 2 to get PTPERDivide count period value by 2 to get PTPER
PWM frequency is halved for center-alignedPWM frequency is halved for center-aligned
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Motor Control PWMMotor Control PWMMotor Control PWM

Duty Cycle Comparison Block DiagramDuty Cycle Comparison Block DiagramDuty Cycle Comparison Block Diagram

PTMR

PDCx

16-bit Compare

D Tcy/2

01415

115

PTDIR

Tcy
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Motor Control PWMMotor Control PWMMotor Control PWM

PWM Formula for Center Aligned PWM

PWM Formula for Edge Aligned PWM

PWM Formula for Center Aligned PWMPWM Formula for Center Aligned PWM

PWM Formula for Edge Aligned PWMPWM Formula for Edge Aligned PWM

PTPER = (Fcy/Fpwm - 1)/2 

PTPER = (Fcy/Fpwm - 1) 
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Motor Control PWMMotor Control PWMMotor Control PWM

Complementary output modeComplementary output modeComplementary output mode

PWM Generator

VDD

Dead Band

PWMxH

PWMxL

+V

1H

1L

2H

2L

3H

3L

3 Phase
BLDC or

ACIM
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Motor Control PWMMotor Control PWMMotor Control PWM

PWMCON1 register
PWM output enable bits
PWM output mode select

For labs, enable PWM1, PWM2, and PWM3
pairs for complementary mode

PWMCON1 registerPWMCON1 register
PWM output enable bitsPWM output enable bits
PWM output mode selectPWM output mode select

For labs, enable PWM1, PWM2, and PWM3For labs, enable PWM1, PWM2, and PWM3
pairs for complementary modepairs for complementary mode

PMOD1
U-0 U-0 U-0 U-0 R/W-0 R/W-0 R/W-0 R/W-0

bit15 14 13 12 11 10 9 bit8
PMOD2PMOD3PMOD4----

PEN1L
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1 bit0
PEN2LPEN3LPEN4LPEN1HPEN2HPEN3HPEN4H
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Motor Control PWMMotor Control PWMMotor Control PWM

Dead Time Generators
Two programmable dead times

one for dsPIC2010
Control bits choose dead time for
active/inactive events
Two ways to use DTA and DTB
Tcy minimum resolution
Prescalers for increased dead time range

Dead Time GeneratorsDead Time Generators
Two programmable dead timesTwo programmable dead times

one for dsPIC2010one for dsPIC2010
Control bits choose dead time forControl bits choose dead time for
active/inactive eventsactive/inactive events
Two ways to use DTA and DTBTwo ways to use DTA and DTB
Tcy minimum resolutionTcy minimum resolution
Prescalers for increased dead time rangePrescalers for increased dead time range
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MCPWM Dead Time InsertionMCPWM Dead Time InsertionMCPWM Dead Time Insertion

Applies only to pin pairs in complimentary mode
Two programmable dead times
One dead time per pair for multiple inverters OR
Two dead times per pair for distortion optimization
Tcy minimum resolution with four pre-scale options

Applies only to pin pairs in complimentary modeApplies only to pin pairs in complimentary mode
Two programmable dead timesTwo programmable dead times
One dead time per pair for multiple inverters OROne dead time per pair for multiple inverters OR
Two dead times per pair for distortion optimizationTwo dead times per pair for distortion optimization
TTcycy minimum resolution with four pre-scale options minimum resolution with four pre-scale options

Dead Time ADead Time A Dead Time BDead Time B

PWM1HPWM1H

PWM1LPWM1L

PWM1HPWM1H

PWM1LPWM1L
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Motor Control PWMMotor Control PWMMotor Control PWM

DTCON1 selects dead time value for A and B

DTCON2 selects which dead time value is
assigned to the active(A) or inactive(I) edge of
each generator

DTCON1 selects dead time value for A and BDTCON1 selects dead time value for A and B

DTCON2 selects which dead time value isDTCON2 selects which dead time value is
assigned to the active(A) or inactive(I) edge ofassigned to the active(A) or inactive(I) edge of
each generatoreach generator

DTS1I
bit7 6 5 4 3 2 1 bit0

DTS1ADTS2IDTS2ADTS3IDTS3ADTS4IDTS4A

-
bit15 14 13 12 11 10 9 bit8

-------

bit7 6 5 4 3 2 1 bit0
DTA<5:0>DTAPS0DTAPS1

bit15 14 13 12 11 10 9 bit8
DTB<5:0DTBPS0DTBPS1
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MCPWM Fault InputsMCPWM Fault InputsMCPWM Fault Inputs

Two programmable fault pins:  Fault A, Fault B
dsPIC2010 only has Fault A

Fault pins can be assigned to each output pair
Fault state for each output is programmable
Automatic or latched fault protection
Interrupt vector for each fault input
Fault A has priority over Fault B
Fault condition overrides all other pin control
Fault pins can be used as interrupt pins when
not used for PWM module

Two programmable fault pins:  Fault A, Fault BTwo programmable fault pins:  Fault A, Fault B
dsPIC2010 only has Fault AdsPIC2010 only has Fault A

Fault pins can be assigned to each output pairFault pins can be assigned to each output pair
Fault state for each output is programmableFault state for each output is programmable
Automatic or latched fault protectionAutomatic or latched fault protection
Interrupt vector for each fault inputInterrupt vector for each fault input
Fault A has priority over Fault BFault A has priority over Fault B
Fault condition overrides all other pin controlFault condition overrides all other pin control
Fault pins can be used as interrupt pins whenFault pins can be used as interrupt pins when
not used for PWM modulenot used for PWM module
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Motor Control PWMMotor Control PWMMotor Control PWM

FLTACON Register
FAENx - Enables pin pair for control by fault pin
FLTAM - Latched or cycle-by-cycle mode
FAOVxx - Override value bits

FLTBCON register is identical
For labs - FLTA drives all outputs inactive, latched
mode

FLTACON RegisterFLTACON Register
FAENx - Enables pin pair for control by fault pinFAENx - Enables pin pair for control by fault pin
FLTAM - Latched or cycle-by-cycle modeFLTAM - Latched or cycle-by-cycle mode
FAOVxx - Override value bitsFAOVxx - Override value bits

FLTBCON register is identicalFLTBCON register is identical
For labs - FLTA drives all outputs inactive, latchedFor labs - FLTA drives all outputs inactive, latched
modemode

FAEN1
bit7 6 5 4 3 2 1 bit0

FAEN2FAEN3FAEN4---FLTAM

FAOV1L
bit15 14 13 12 11 10 9 bit8

FAOV1HFAOV2LFAOV2HFAOV3LFAOV3HFAOV4LFAOV4H
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MCPWM A/D SynchronizationMCPWM A/D Synchronization

SEVTCMP register sets A/D conversion start time in PWM
cycle
Ensure A/D properly captures shunt current
Can also use to minimize control loop update delay

SEVTCMP register sets A/D conversion start time in PWM
cycle
Ensure A/D properly captures shunt current
Can also use to minimize control loop update delay

To A/D

PWM1LPWM1L
PWM1HPWM1H

PWM1HPWM1H

PWM1LPWM1L

Trigger  conversion at end of bottom transistor on-timeTrigger  conversion at end of bottom transistor on-time

TT
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Lab 3 ObjectivesLab 3 ObjectivesLab 3 Objectives

3 MC PWM pairs are connected to 3 ADC
inputs
MC PWMs will be driven with a 25%, 50%
and 75% duty cycle
The average of the duty cycle will be
measured by each ADC
If the configuration is correct then the 3 ADC
value displayed will be 1.8V, 2.8V and 3.75V
using Hyperterm

3 MC PWM pairs are connected to 3 ADC3 MC PWM pairs are connected to 3 ADC
inputsinputs
MC PWMs will be driven with a 25%, 50%MC PWMs will be driven with a 25%, 50%
and 75% duty cycleand 75% duty cycle
The average of the duty cycle will beThe average of the duty cycle will be
measured by each ADCmeasured by each ADC
If the configuration is correct then the 3 ADCIf the configuration is correct then the 3 ADC
value displayed will be 1.8V, 2.8V and 3.75Vvalue displayed will be 1.8V, 2.8V and 3.75V
using Hypertermusing Hyperterm
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Lab 3 HardwareLab 3 HardwareLab 3 Hardware
+V

1H

1L

2H

2L

3H

3L

AN3

AN5

AN4

PWM1

PWM2

PWM3
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Lab3 Jumper settingsLab3 Jumper settingsLab3 Jumper settings

J2(2 pin)  - shorted.
J15(3 pin) - shorted between pin 2 & 3
(short link towards the crystal oscillator)

J7, J11 and J13 - shorted between pin 2 & 3
(short link away from ICD 2 connector)

JP8, JP12, JP14, JP16 and JP17 keep open
Keep Potentiometer REF(R14) and R60 in
center position

J2J2(2 pin)  - shorted.(2 pin)  - shorted.
J15J15(3 pin) - shorted between pin 2 & 3(3 pin) - shorted between pin 2 & 3
(short link towards the crystal oscillator)(short link towards the crystal oscillator)

J7, J11J7, J11 and  and J13J13 - shorted between pin 2 & 3 - shorted between pin 2 & 3
(short link away from ICD 2 connector)(short link away from ICD 2 connector)

JP8, JP12, JP14, JP16 and JP17JP8, JP12, JP14, JP16 and JP17 keep open keep open
Keep Potentiometer Keep Potentiometer REF(R14) and R60REF(R14) and R60 in in
center positioncenter position
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Lab 3 ObjectivesLab 3 ObjectivesLab 3 Objectives

Learn to setup the MC PWM period, duty
cycle, dead time, ADC trigger etc.
Learn to setup the ADC for simultaneous
sampling and conversion on multiple
channels

Learn to setup the MC PWM period, dutyLearn to setup the MC PWM period, duty
cycle, dead time, ADC trigger etc.cycle, dead time, ADC trigger etc.
Learn to setup the ADC for simultaneousLearn to setup the ADC for simultaneous
sampling and conversion on multiplesampling and conversion on multiple
channelschannels
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Lab3 SetupLab3 SetupLab3 Setup

Lab 3:
Part 1: Setup ADC

ADC to simultaneously sample 4 channels
Set CH0 - AN2(Pot), CH1 - AN3, CH2 -
AN4 and CH3 - AN5.  Vref- = GND
Trigger Conversion with 16 PWM Periods
Set Tad = 4Tcy
Modify Registers ADCON1, ADCON2,
ADCON3, ADCHS and ADPCFG
Code to be modified is clearly marked

Lab 3:Lab 3:
Part 1: Setup ADCPart 1: Setup ADC

ADC to simultaneously sample 4 channelsADC to simultaneously sample 4 channels
Set CH0 - AN2(Pot), CH1 - AN3, CH2 -Set CH0 - AN2(Pot), CH1 - AN3, CH2 -
AN4 and CH3 - AN5.  Vref- = GNDAN4 and CH3 - AN5.  Vref- = GND
Trigger Conversion with 16 PWM PeriodsTrigger Conversion with 16 PWM Periods
Set Tad = 4TcySet Tad = 4Tcy
Modify Registers ADCON1, ADCON2,Modify Registers ADCON1, ADCON2,
ADCON3, ADCHS and ADPCFGADCON3, ADCHS and ADPCFG
Code to be modified is clearly markedCode to be modified is clearly marked



© 2004 Microchip Technology Incorporated. All Rights Reserved.     845 SNS 845 SNS     Sensor and Sensorless Control of a BLDC motor using a dsPIC     Sensor and Sensorless Control of a BLDC motor using a dsPIC® ® DSC      DSC       76

Lab 3 Setup (contd.)Lab 3 Setup (contd.)Lab 3 Setup (contd.)

Lab3 :
Part 2: setup MC PWM

Setup for continuous center aligned PWM
Complementary pairs
Fcy = 20Mips , PWM Freq = 80khz
PDC1 = 25%, PDC2 = 50% PDC3 = 75%
Dead time = 1 uS (active and inactive)
Code to be modified is clearly marked

Lab3 :Lab3 :
Part 2: setup MC PWMPart 2: setup MC PWM

Setup for continuous center aligned PWMSetup for continuous center aligned PWM
Complementary pairsComplementary pairs
Fcy = 20Mips , PWM Freq = 80khzFcy = 20Mips , PWM Freq = 80khz
PDC1 = 25%, PDC2 = 50% PDC3 = 75%PDC1 = 25%, PDC2 = 50% PDC3 = 75%
Dead time = 1 uS (active and inactive)Dead time = 1 uS (active and inactive)
Code to be modified is clearly markedCode to be modified is clearly marked
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Lab 3 Setup (contd.)Lab 3 Setup (contd.)Lab 3 Setup (contd.)

Lab 3 General:
Use workspace in:
“C:\MASTERs\845\Lab3\Lab3.mcw”
Do not connect the motor to the board
Use Hyperterm setup: “Lab2.ht” in Lab3
directory to view results of the ADC
Make sure that DIPs are in CLOSE position
when programming
Make sure that DIPs are in OPEN position
when running

Lab 3 General:Lab 3 General:
Use workspace in:Use workspace in:
“C:\MASTERs\845\Lab3\Lab3.mcw”“C:\MASTERs\845\Lab3\Lab3.mcw”
Do not connect the motor to the boardDo not connect the motor to the board
Use Hyperterm setup: “Lab2.ht” in Lab3Use Hyperterm setup: “Lab2.ht” in Lab3
directory to view results of the ADCdirectory to view results of the ADC
Make sure that DIPs are in CLOSE positionMake sure that DIPs are in CLOSE position
when programmingwhen programming
Make sure that DIPs are in OPEN positionMake sure that DIPs are in OPEN position
when runningwhen running
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Lab3 ResultLab3 ResultLab3 Result
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Lab 3 ResultsLab 3 ResultsLab 3 Results

Learned how to setup the ADC
Learned how to setup the PWM
We should now have sufficient information
to setup a simple sensored control of a
BLDC motor

Learned how to setup the ADCLearned how to setup the ADC
Learned how to setup the PWMLearned how to setup the PWM
We should now have sufficient informationWe should now have sufficient information
to setup a simple sensored control of ato setup a simple sensored control of a
BLDC motorBLDC motor
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Brushless DC Motor ConstructionBrushless DC Motor ConstructionBrushless DC Motor Construction
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Standard BLDC ControlStandard BLDC ControlStandard BLDC Control

+TORQUE FIRING

R Y B

Q1 Q3Q2

Q4 Q6Q5

Q1,Q5 Q1,Q6 Q2,Q6 Q2,Q4 Q3,Q4 Q3,Q5

60o

HALL A

HALL B

HALL C

Q1,Q5 Q1,Q6Q3,Q5

Sector 5

Hall States
0 1 2

5 4 6 2

3

3
4

1

5
5

0
4

1
6

Blue Winding

Yellow Winding

Red Winding
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Standard Sensored BLDC
Control

Standard Sensored BLDCStandard Sensored BLDC
ControlControl

The 3 logic signals are decoded to determine
which windings should be energized.
There are 6 valid states and 2 states that should
never be seen (000, 111).
Use Lookup table to drive the 3 windings, high or
low or no-drive.
The 6 different valid states directly translate to the
6 different 60° electrical cycle sectors.
The states should only transition by one at a time.
Missing transitions or invalid states should be
detected for robust operation.

The 3 logic signals are decoded to determineThe 3 logic signals are decoded to determine
which windings should be energized.which windings should be energized.
There are 6 valid states and 2 states that shouldThere are 6 valid states and 2 states that should
never be seen (000, 111).never be seen (000, 111).
Use Lookup table to drive the 3 windings, high orUse Lookup table to drive the 3 windings, high or
low or no-drive.low or no-drive.
The 6 different valid states directly translate to theThe 6 different valid states directly translate to the
6 different 606 different 60°° electrical cycle sectors. electrical cycle sectors.
The states should only transition by one at a time.The states should only transition by one at a time.
Missing transitions or invalid states should beMissing transitions or invalid states should be
detected for robust operation.detected for robust operation.
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Standard BLDC Position SensingStandard BLDC Position SensingStandard BLDC Position Sensing

5 0 1 2 3 4 5 0 1SECTOR

60o

HALL R

HALL Y

HALL B

HALL STATE
RYB

5 4 6 2 3 1 5 4 6
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Hall sensors

Stator winding
Rotor magnets

BLDC Motor ConstructionBLDC Motor ConstructionBLDC Motor Construction
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Control of Sensored BLDCControl of Sensored BLDCControl of Sensored BLDC

Simple Control Technique:
Sense change in state of position
Read Hall sensors to determine the new state
Use lookup table for commutation
Use PWM for speed control

Simple Control Technique:Simple Control Technique:
Sense change in state of positionSense change in state of position
Read Hall sensors to determine the new stateRead Hall sensors to determine the new state
Use lookup table for commutationUse lookup table for commutation
Use PWM for speed controlUse PWM for speed control
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Change Notification (CN)Change Notification (CN)Change Notification (CN)

dsPIC® DSC has Change Notification inputs:
Detect digital changes on a specific input pin
and generates an interrupt
Hall sensors A, B and C are connected to RB3,
4 and 5 or CN4, 5 and 6 respectively.
When CNxInterrupt occurs, all 3 Hall inputs are
read and a lookup table is used to control the
BLDC motor

dsPICdsPIC®® DSC has Change Notification inputs: DSC has Change Notification inputs:
Detect digital changes on a specific input pinDetect digital changes on a specific input pin
and generates an interruptand generates an interrupt
Hall sensors A, B and C are connected to RB3,Hall sensors A, B and C are connected to RB3,
4 and 5 or CN4, 5 and 6 respectively.4 and 5 or CN4, 5 and 6 respectively.
When CNxInterrupt occurs, all 3 Hall inputs areWhen CNxInterrupt occurs, all 3 Hall inputs are
read and a lookup table is used to control theread and a lookup table is used to control the
BLDC motorBLDC motor
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CN HardwareCN HardwareCN Hardware
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Motor Control PWM -
Manual Override Control

Motor Control PWM -Motor Control PWM -
Manual Override ControlManual Override Control

Four PWM outputFour PWM output
pairs with outputpairs with output
polarity controlpolarity control

Duty CycleDuty Cycle

Generator #3Generator #3

Duty CycleDuty Cycle

Generator #2Generator #2

Duty CycleDuty Cycle

Generator #1Generator #1

Duty CycleDuty Cycle

Generator #4Generator #4

PWM OutputPWM Output
Control LogicControl Logic

Dead Time UnitDead Time Unit

Dead Time UnitDead Time Unit

Dead Time UnitDead Time Unit

Dead Time UnitDead Time Unit

Fault AFault A

Fault BFault B

PWM4HPWM4H

PWM1LPWM1L

PWM1HPWM1H

PWM2LPWM2L

PWM2HPWM2H

PWM3LPWM3L

PWM3HPWM3H

PWM4LPWM4L

Two fault pins w/Two fault pins w/
programmable faultprogrammable fault

statesstates

15-bit Time-base15-bit Time-base

A/D ConversionA/D Conversion
TriggerTrigger

Manual OverrideManual Override
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Motor Control PWMMotor Control PWMMotor Control PWM

 OVDCON (override control) register
Used for motor commutation
I/O pin can be PWM, active, or inactive
POVD =0,  I/O pin is controlled manually
POUT bits set pin state for manual control
Dead time requirements are always
satisfied in complementary mode

 OVDCON (override control) register OVDCON (override control) register
Used for motor commutationUsed for motor commutation
I/O pin can be PWM, active, or inactiveI/O pin can be PWM, active, or inactive
POVD =0,  I/O pin is controlled manuallyPOVD =0,  I/O pin is controlled manually
POUT bits set pin state for manual controlPOUT bits set pin state for manual control
Dead time requirements are alwaysDead time requirements are always
satisfied in complementary modesatisfied in complementary mode

POUT1L
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1 bit0
POUT1HPOUT2LPOUT2HPOUT3LPOUT3HPOUT4LPOUT4H

POVD1L
R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1

bit15 14 13 12 11 10 9 bit8
POVD1HPOVD2LPOVD2HPOVD3LPOVD3HPOVD4LPOVD4H
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2 3 4 5 61

PWM1H

PWM1L

PWM2H

PWM2L

PWM3H

PWM3L

1 Electrical Revolution

Motor Control PWMMotor Control PWMMotor Control PWM

Using OVDCON for BLDC commutationUsing OVDCON for BLDC commutationUsing OVDCON for BLDC commutation

POVD<7:0> POUT<7:0>

1 00000010 00000100

2 00000010 00010000

3 00001000 00010000

4 00001000 00000001

5 00100000 00000001

6 00100000 00000100

OVDCON Value
Step
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Lab4 Jumper settingsLab4 Jumper settingsLab4 Jumper settings

J2(2 pin)  - shorted.
J15(3 pin) - shorted between pin 2 & 3
(short link towards the crystal oscillator)

J7, J11 and J13 - shorted between pin 2 & 1
(short link towards ICD 2 connector)

JP8, JP12, JP14, JP16 and JP17 keep open
Keep Potentiometer REF(R14) and R60 in
center position

J2J2(2 pin)  - shorted.(2 pin)  - shorted.
J15J15(3 pin) - shorted between pin 2 & 3(3 pin) - shorted between pin 2 & 3
(short link towards the crystal oscillator)(short link towards the crystal oscillator)

J7, J11J7, J11 and  and J13J13 -  - shorted between pin 2 & 1shorted between pin 2 & 1
(short link towards ICD 2 connector)(short link towards ICD 2 connector)

JP8, JP12, JP14, JP16 and JP17JP8, JP12, JP14, JP16 and JP17 keep open keep open
Keep Potentiometer Keep Potentiometer REF(R14) and R60REF(R14) and R60 in in
center positioncenter position
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Lab 4: Sensored ControlLab 4: Sensored ControlLab 4: Sensored Control

Lab 4:
Part A: Setup CNxInterrupts

Set up CNx interrupt vectors to sense
changes in Hall sensors
Read PORTB and check States (3-bits)
Use Lookup table to set up the Override
Control Register
Lookup Table already Provided as
“StateLoTable[0,1,2,3,4,5,6,7]”
Note: States 0 and 7 are illegal

Lab 4:Lab 4:
Part A: Setup CNxInterruptsPart A: Setup CNxInterrupts

Set up CNx interrupt vectors to senseSet up CNx interrupt vectors to sense
changes in Hall sensorschanges in Hall sensors
Read PORTB and check States (3-bits)Read PORTB and check States (3-bits)
Use Lookup table to set up the OverrideUse Lookup table to set up the Override
Control RegisterControl Register
Lookup Table already Provided asLookup Table already Provided as
“StateLoTable[0,1,2,3,4,5,6,7]”“StateLoTable[0,1,2,3,4,5,6,7]”
Note: States 0 and 7 are illegalNote: States 0 and 7 are illegal
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Lab 4: Sensored Control
(contd.)

Lab 4: Sensored ControlLab 4: Sensored Control
(contd.)(contd.)

Lab 4:
Part B: Setup PWM

Set period to 10-bit,  4.9 kHz @ 5 Mips
Set Duty Cycle = ADC input on Pot REF
Set for Edge Aligned PWM
Dead Time not required
Initialize the OVDCON register for override
control

Lab 4:Lab 4:
Part B: Setup PWMPart B: Setup PWM

Set period to 10-bit,  4.9 kHz @ 5 MipsSet period to 10-bit,  4.9 kHz @ 5 Mips
Set Duty Cycle = ADC input on Pot REFSet Duty Cycle = ADC input on Pot REF
Set for Edge Aligned PWMSet for Edge Aligned PWM
Dead Time not requiredDead Time not required
Initialize the OVDCON register for overrideInitialize the OVDCON register for override
controlcontrol
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Lab 4: Sensored Control
(contd.)

Lab 4: Sensored ControlLab 4: Sensored Control
(contd.)(contd.)

Lab 4:
Part C: Setup ADC:

Convert single channel on AN2(POT REF)
Use Tad = ADRC
Use Manual Sample by setting SAMP bit
every 100 mS (use Delay100mS routine)
Manually check conversion complete
Load ADC result as Duty Cycle for all
PWMs

Lab 4:Lab 4:
Part C: Setup ADC:Part C: Setup ADC:

Convert single channel on AN2(POT REF)Convert single channel on AN2(POT REF)
Use Tad = ADRCUse Tad = ADRC
Use Manual Sample by setting SAMP bitUse Manual Sample by setting SAMP bit
every 100 mS (use Delay100mS routine)every 100 mS (use Delay100mS routine)
Manually check conversion completeManually check conversion complete
Load ADC result as Duty Cycle for allLoad ADC result as Duty Cycle for all
PWMsPWMs
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Lab 4: Sensored BLDC
(contd.)

Lab 4: Sensored BLDCLab 4: Sensored BLDC
(contd.)(contd.)

Lab 4:
General:

Use workspace in
“C:\MASTERs\845\Lab4\Lab4.mcw”
Position REF to center position
Connect Motor’s Black and white connector
Build project and program part ...
DIPs in CLOSED position for programming
DIPs in OPEN position for running

Lab 4:Lab 4:
General:General:

Use workspace inUse workspace in
“C:\MASTERs\845\Lab4\Lab4.mcw”“C:\MASTERs\845\Lab4\Lab4.mcw”
Position REF to center positionPosition REF to center position
Connect Motor’s Black and white connectorConnect Motor’s Black and white connector
Build project and program part ...Build project and program part ...
DIPs in CLOSED position for programmingDIPs in CLOSED position for programming
DIPs in OPEN position for runningDIPs in OPEN position for running
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Lab 4 ResultsLab 4 ResultsLab 4 Results

We learned how to control a sensored BLDC
motor
We controlled speed of the motor by using a
potentiometer

Now let us look at Sensorless Contol of a
BLDC motor

We learned how to control a sensored BLDCWe learned how to control a sensored BLDC
motormotor
We controlled speed of the motor by using aWe controlled speed of the motor by using a
potentiometerpotentiometer

Now let us look at Sensorless Contol of aNow let us look at Sensorless Contol of a
BLDC motorBLDC motor
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Sensorless BLDC MotorSensorless BLDC MotorSensorless BLDC Motor
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Why sensorless?Why sensorless?Why sensorless?

Reliability – especially aerospace, military
Physical space restrictions – axial length
Issues surrounding sealing of connections
Applications where rotor runs “flooded”
Manufacturability – alignment and duty cycle
tolerance
Cost – especially on low power systems

Even at high volumes, position sensing can
add $3 to system cost

Reliability – especially aerospace, militaryReliability – especially aerospace, military
Physical space restrictions – axial lengthPhysical space restrictions – axial length
Issues surrounding sealing of connectionsIssues surrounding sealing of connections
Applications where rotor runs “flooded”Applications where rotor runs “flooded”
Manufacturability – alignment and duty cycleManufacturability – alignment and duty cycle
tolerancetolerance
Cost – especially on low power systemsCost – especially on low power systems

Even at high volumes, position sensing canEven at high volumes, position sensing can
add $3 to system costadd $3 to system cost
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BLDC Sensorless TechniquesBLDC Sensorless TechniquesBLDC Sensorless Techniques

Many method to sense rotor position
AN901 uses Back EMF sensing

Reliable
Varies linearly with speed
Works over a wide range of BLDC Motors
Relatively easy to implement
Works well for applications like Fan or pump speed
control

Method used is called Back EMF “zero crossing”
method

Consists of monitoring the voltage of the inactive
winding

Many method to sense rotor positionMany method to sense rotor position
AN901 uses Back EMF sensingAN901 uses Back EMF sensing

ReliableReliable
Varies linearly with speedVaries linearly with speed
Works over a wide range of BLDC MotorsWorks over a wide range of BLDC Motors
Relatively easy to implementRelatively easy to implement
Works well for applications like Fan or pump speedWorks well for applications like Fan or pump speed
controlcontrol

Method used is called Back EMF “zero crossing”Method used is called Back EMF “zero crossing”
methodmethod

Consists of monitoring the voltage of the inactiveConsists of monitoring the voltage of the inactive
windingwinding
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What is BEMF?What is BEMF?What is BEMF?

When a DC motor spins,
the PM rotor, moving
past the stator coils
induces a electrical
potential in the coils
called Back EMF
BEMF is directly
proportional to speed
BEMF = RPM/Kv
In order to sense BEMF
we have to spin the
motor

When a DC motor spins,When a DC motor spins,
the PM rotor, movingthe PM rotor, moving
past the stator coilspast the stator coils
induces a electricalinduces a electrical
potential in the coilspotential in the coils
called Back EMFcalled Back EMF
BEMF is directlyBEMF is directly
proportional to speedproportional to speed
BEMF = RPM/KvBEMF = RPM/Kv
In order to sense BEMFIn order to sense BEMF
we have to spin thewe have to spin the
motormotor

BEMF

Motor

R L
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BLDC Motor Back EMFBLDC Motor Back EMFBLDC Motor Back EMF

A

C B

DC+

DC-

Back EMF

Phase A and C are
energized
Inactive Phase B has
induced Back EMF
Normally the phase
which is not
energized,  is
monitored for Back
EMF
Important: Motor has
to be spinning

Phase A and C arePhase A and C are
energizedenergized
Inactive Phase B hasInactive Phase B has
induced Back EMFinduced Back EMF
Normally the phaseNormally the phase
which is notwhich is not
energized,  isenergized,  is
monitored for Backmonitored for Back
EMFEMF
Important: Motor hasImportant: Motor has
to be spinningto be spinning
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Technique to Monitor Back
EMF

Technique to Monitor BackTechnique to Monitor Back
EMFEMF

A

C B

DC+

DC-

DC/2

+
_

Back EMF

To IC2
BZ_B

+
_ To IC1

BZ_A

+
_ To IC3

BZ_C

• Back EMF signal compared with DC bus/2
using external comparators

ds
PI

C
30

F2
01

0

CN3

CN1

CN2
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Technique to Monitor Back
EMF

Technique to Monitor BackTechnique to Monitor Back
EMFEMF

• Back EMF signal compared with virtual neutral

A

C
B

DC+

DC-

Virtual
Neutral

+
_

Back EMF

+
_ To IC1

BZ_A

+
_ To IC3

BZ_C

To IC2
BZ_B

ds
PI

C
30

F2
01

0

CN3

CN1

CN2
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Technique to Monitor Back
EMF

Technique to Monitor BackTechnique to Monitor Back
EMFEMF

• Back EMF signal read using A/D Channels

A

C B

AN0

AN1

AN2

Back EMF

Si
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 C
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di
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BEMF vs. Hall sensorsBEMF vs. Hall sensorsBEMF vs. Hall sensors

Back EMF

Hall sensor
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How to “Start Spinning”How to “Start Spinning”How to “Start Spinning”

The motor is energized Open Loop (no feedback)
The speed is ramped up to a programmable value
The windings are then de-energized, so the rotor
will coast
The windings are then monitored for two rising
edges (120 degree information)
From the time and sequencing of the edges we
can determine the speed and rotation direction
The BEMF sensing algorithm is now applied to
rotate the motor

The motor is energized Open Loop (no feedback)The motor is energized Open Loop (no feedback)
The speed is ramped up to a programmable valueThe speed is ramped up to a programmable value
The windings are then de-energized, so the rotorThe windings are then de-energized, so the rotor
will coastwill coast
The windings are then monitored for two risingThe windings are then monitored for two rising
edges (120 degree information)edges (120 degree information)
From the time and sequencing of the edges weFrom the time and sequencing of the edges we
can determine the speed and rotation directioncan determine the speed and rotation direction
The BEMF sensing algorithm is now applied toThe BEMF sensing algorithm is now applied to
rotate the motorrotate the motor
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Standard BLDC Position SensingStandard BLDC Position SensingStandard BLDC Position Sensing

5 0 1 2 3 4 5 0 1SECTOR

60o

HALL R

HALL Y

HALL B

HALL STATE
RYB

5 4 6 2 3 1 5 4 6
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The Back EMF “zero crossing”
method in detail

The Back EMF “zero crossing”The Back EMF “zero crossing”
method in detailmethod in detail

In every electrical cycle, there are periods when each
phase is not being driven.
During these regions one end of the inactive phase is
referenced to the star point and the other is monitored.
The monitored voltage will cross the 1/2 Vdd point at
30 electrical degrees.
Knowing the last “zero crossing” time we now know
the 60 electrical degree time.
That value is divided by 2 and loaded in a second
timer.
The ISR of the 2nd timer then commutes the windings
at 30 electrical degrees later.

In every electrical cycle, there are periods when eachIn every electrical cycle, there are periods when each
phase is not being driven.phase is not being driven.
During these regions one end of the inactive phase isDuring these regions one end of the inactive phase is
referenced to the star point and the other is monitored.referenced to the star point and the other is monitored.
The monitored voltage will cross the 1/2 Vdd point atThe monitored voltage will cross the 1/2 Vdd point at
30 electrical degrees.30 electrical degrees.
Knowing the last “zero crossing” time we now knowKnowing the last “zero crossing” time we now know
the 60 electrical degree time.the 60 electrical degree time.
That value is divided by 2 and loaded in a secondThat value is divided by 2 and loaded in a second
timer.timer.
The ISR of the 2nd timer then commutes the windingsThe ISR of the 2nd timer then commutes the windings
at 30 electrical degrees later.at 30 electrical degrees later.
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Back EMF Crossing DiagramBack EMF Crossing DiagramBack EMF Crossing Diagram

5 0 1 2 3 4 5 0 1SECTOR
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dsPIC® DSC ImplementationdsPICdsPIC®® DSC Implementation DSC Implementation

High speed ADC of dsPIC DSC essential for high
sampling rate
Voltage monitor is done by resistor dividers

Lower cost for customer
no external comparators used

Single chip solution for customer
cost advantage

PID control done using the dsPIC DSC engine
AN901 is used to discuss the Sensorless BLDC
technique using a dsPIC DSC

High speed ADC of dsPIC DSC essential for highHigh speed ADC of dsPIC DSC essential for high
sampling ratesampling rate
Voltage monitor is done by resistor dividersVoltage monitor is done by resistor dividers

Lower cost for customerLower cost for customer
no external comparators usedno external comparators used

Single chip solution for customerSingle chip solution for customer
cost advantagecost advantage

PID control done using the dsPIC DSC enginePID control done using the dsPIC DSC engine
AN901 is used to discuss the Sensorless BLDCAN901 is used to discuss the Sensorless BLDC
technique using a dsPIC DSCtechnique using a dsPIC DSC
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Starting Algorithm
Parameters

used in AN901

Starting AlgorithmStarting Algorithm
ParametersParameters

used in AN901used in AN901
Lock Position 1 Time

Before start motor is rotated to a known
position
The time is amount of time that the rotor is held
in that position

Lock Position 1 Demand
speed at which the rotor moves to the lock
position
if value is too high then rotor may overshoot
position

Lock Position 1 TimeLock Position 1 Time
Before start motor is rotated to a knownBefore start motor is rotated to a known
positionposition
The time is amount of time that the rotor is heldThe time is amount of time that the rotor is held
in that positionin that position

Lock Position 1 DemandLock Position 1 Demand
speed at which the rotor moves to the lockspeed at which the rotor moves to the lock
positionposition
if value is too high then rotor may overshootif value is too high then rotor may overshoot
positionposition



© 2004 Microchip Technology Incorporated. All Rights Reserved.     845 SNS 845 SNS     Sensor and Sensorless Control of a BLDC motor using a dsPIC     Sensor and Sensorless Control of a BLDC motor using a dsPIC® ® DSC      DSC       112

Starting Algorithm
Parameters used in AN901

(contd.)

Starting AlgorithmStarting Algorithm
Parameters used in AN901Parameters used in AN901

(contd.)(contd.)
Ramp Start/End Speed:

Open loop speed to get the rotor moving
before back EMF is monitored
Too low a speed will not generate enough back
EMF
Too high a speed may cause an over-current
stall
After Ramp Start speed the system increases
speed to the End over the Ramp Duration
Simply put: the acceleration profile

Ramp Start/End Speed:Ramp Start/End Speed:
Open loop speed to get the rotor movingOpen loop speed to get the rotor moving
before back EMF is monitoredbefore back EMF is monitored
Too low a speed will not generate enough backToo low a speed will not generate enough back
EMFEMF
Too high a speed may cause an over-currentToo high a speed may cause an over-current
stallstall
After Ramp Start speed the system increasesAfter Ramp Start speed the system increases
speed to the End over the Ramp Durationspeed to the End over the Ramp Duration
Simply put: the acceleration profileSimply put: the acceleration profile



© 2004 Microchip Technology Incorporated. All Rights Reserved.     845 SNS 845 SNS     Sensor and Sensorless Control of a BLDC motor using a dsPIC     Sensor and Sensorless Control of a BLDC motor using a dsPIC® ® DSC      DSC       113

Starting Algorithm
Parameters used in AN901

(contd.)

Starting AlgorithmStarting Algorithm
Parameters used in AN901Parameters used in AN901

(contd.)(contd.)

Ramp Start/End Demand:
The amount of “torque” required to spin the
motor without slipping
If the rotor appears to be spinning slowly as the
ramp time proceeds then the ramp demand
needs to be increased
If the whole motor vibrated when the ramp time
increases then the demand is too high and
most likely the over current will trip.

Ramp Start/End Demand:Ramp Start/End Demand:
The amount of “torque” required to spin theThe amount of “torque” required to spin the
motor without slippingmotor without slipping
If the rotor appears to be spinning slowly as theIf the rotor appears to be spinning slowly as the
ramp time proceeds then the ramp demandramp time proceeds then the ramp demand
needs to be increasedneeds to be increased
If the whole motor vibrated when the ramp timeIf the whole motor vibrated when the ramp time
increases then the demand is too high andincreases then the demand is too high and
most likely the over current will trip.most likely the over current will trip.
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Lab5 Jumper settingsLab5 Jumper settingsLab5 Jumper settings
J2(2 pin)  - shorted
J15(3 pin) - shorted between pin 2 & 3
(short link towards the crystal oscillator)

J7, J11 and J13 - shorted between pin 2 & 3
(short link away from ICD 2 connector)

JP8, JP12, JP14, JP16 and JP17 keep open
Keep Potentiometer REF(R14) and R60 in
center position
Disconnect Hall Sensors from Motor (Black
connector)

J2J2(2 pin)  - shorted(2 pin)  - shorted
J15J15(3 pin) - shorted between pin 2 & 3(3 pin) - shorted between pin 2 & 3
(short link towards the crystal oscillator)(short link towards the crystal oscillator)

J7, J11J7, J11 and  and J13J13 -  - shorted between pin 2 & 3shorted between pin 2 & 3
(short link away from ICD 2 connector)(short link away from ICD 2 connector)

JP8, JP12, JP14, JP16 and JP17JP8, JP12, JP14, JP16 and JP17 keep open keep open
Keep Potentiometer Keep Potentiometer REF(R14) and R60REF(R14) and R60 in in
center positioncenter position
Disconnect Hall Sensors from Motor (BlackDisconnect Hall Sensors from Motor (Black
connector)connector)



© 2004 Microchip Technology Incorporated. All Rights Reserved.     845 SNS 845 SNS     Sensor and Sensorless Control of a BLDC motor using a dsPIC     Sensor and Sensorless Control of a BLDC motor using a dsPIC® ® DSC      DSC       115

Lab 5: Spinning a Sensorless
BLDC Motor

Lab 5: Spinning a SensorlessLab 5: Spinning a Sensorless
BLDC MotorBLDC Motor

Lab 5:
Use workspace
“C:\MASTERs\845\Lab5\Lab5.mcw”
Disconnect Black Connector from Motor
Change Setup parameters to start BLDC motor

Lock Position 1 Time
Lock Position 1 Demand
Ramp Start/End Speed
Ramp Start/End Demand
Ramp Duration

Lab 5:Lab 5:
Use workspaceUse workspace
“C:\MASTERs\845\Lab5\Lab5.mcw”“C:\MASTERs\845\Lab5\Lab5.mcw”
Disconnect Black Connector from MotorDisconnect Black Connector from Motor
Change Setup parameters to start BLDC motorChange Setup parameters to start BLDC motor

Lock Position 1 TimeLock Position 1 Time
Lock Position 1 DemandLock Position 1 Demand
Ramp Start/End SpeedRamp Start/End Speed
Ramp Start/End DemandRamp Start/End Demand
Ramp DurationRamp Duration
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Lab 5: Spinning a Sensorless
BLDC Motor (contd.)

Lab 5: Spinning a SensorlessLab 5: Spinning a Sensorless
BLDC Motor (contd.)BLDC Motor (contd.)

Lab5:
Change values as per handout
Compile program for no errors
Program part with …
DIPs in ON position
Run program with DIPs in OFF position
Press S2 to run the motor

Lab5:Lab5:
Change values as per handoutChange values as per handout
Compile program for no errorsCompile program for no errors
Program part with …Program part with …
DIPs in ON positionDIPs in ON position
Run program with DIPs in OFF positionRun program with DIPs in OFF position
Press S2 to run the motorPress S2 to run the motor
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SummarySummarySummary

BLDC motor basics
dsPIC® DSC Architecture and Peripherals
Programmed the dsPIC DSC ADC
peripheral
Programmed the dsPIC DSC PWM
peripheral
Controlled a Sensored BLDC Motor
Controlled a Sensorless BLDC Motor

BLDC motor basicsBLDC motor basics
dsPICdsPIC®® DSC Architecture and Peripherals DSC Architecture and Peripherals
Programmed the dsPIC DSC ADCProgrammed the dsPIC DSC ADC
peripheralperipheral
Programmed the dsPIC DSC PWMProgrammed the dsPIC DSC PWM
peripheralperipheral
Controlled a Sensored BLDC MotorControlled a Sensored BLDC Motor
Controlled a Sensorless BLDC MotorControlled a Sensorless BLDC Motor
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Thank you for your attendanceThank you for your attendanceThank you for your attendance
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Sensorless BLDC IssuesSensorless BLDC IssuesSensorless BLDC Issues

Phase winding demagnetisation
Stored energy in winding is automatically returned to
the supply via the inverter diodes in a finite time.
BEMF sampling is blanked just after commutation

Coupling from active phases giving PWM “noise”
Adjacent phases induce PWM noise on the inactive
phase
ADC sampling is done asynchronously with the PWM
in order to avoid the “PWM” noise spikes.

Phase winding demagnetisationPhase winding demagnetisation
Stored energy in winding is automatically returned toStored energy in winding is automatically returned to
the supply via the inverter diodes in a finite time.the supply via the inverter diodes in a finite time.
BEMF sampling is blanked just after commutationBEMF sampling is blanked just after commutation

Coupling from active phases giving PWM “noise”Coupling from active phases giving PWM “noise”
Adjacent phases induce PWM noise on the inactiveAdjacent phases induce PWM noise on the inactive
phasephase
ADC sampling is done asynchronously with the PWMADC sampling is done asynchronously with the PWM
in order to avoid the “PWM” noise spikes.in order to avoid the “PWM” noise spikes.
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Trace of PWM “Noise” on Inactive
Phase Terminal Voltage

Trace of PWM “Noise” on InactiveTrace of PWM “Noise” on Inactive
Phase Terminal VoltagePhase Terminal Voltage
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Phase AdvancePhase AdvancePhase Advance

The 30 electrical degree commutation time is
determined in the BEMF algorithm
Since current lags the voltage, energizing the
winding at the precise 30 deg. time may not give
us the right or adequate torque
Phase advance allows us to pre-energize the
winding slightly ahead of the 30 electrical degree
commutation

The 30 electrical degree commutation time isThe 30 electrical degree commutation time is
determined in the BEMF algorithmdetermined in the BEMF algorithm
Since current lags the voltage, energizing theSince current lags the voltage, energizing the
winding at the precise 30 deg. time may not givewinding at the precise 30 deg. time may not give
us the right or adequate torqueus the right or adequate torque
Phase advance allows us to pre-energize thePhase advance allows us to pre-energize the
winding slightly ahead of the 30 electrical degreewinding slightly ahead of the 30 electrical degree
commutationcommutation
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Plots showing the effect of Phase
Advance at High Speed

Plots showing the effect of PhasePlots showing the effect of Phase
Advance at High SpeedAdvance at High Speed
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